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Commands

File
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Collections
Navigation
Help
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Registration and Technical Support

There are two ways to register The Multimedia Encyclopedia of Science 
Fiction:

If you have a Grolier Warranty Card, simply fill it out and mail it in. 

If you don't have a Grolier Warranty Card, or if you prefer, simply call (800) 285-
4535 to register.

Registering will enable us to provide you with better service and will ensure that you 
are notified about specially priced updates.

For technical support:

Call (800) 356-5590, or:

Access the Grolier Bulletin Board Service by modem 24 hours a day.



Grolier Bulletin Board

Contact Grolier by modem 24 hours a day! Grolier Electronic Publishing is now 
offering a Bulletin Board Service to better meet your technical support needs.

You can use the BBS to send our Technical Support team messages concerning any 
problems you encounter. In most cases, you will receive a response to your question 
within one working day. To read our response to you, simply call the    BBS the next 
day.    If we have responded, you will automatically be notified at the time you 
connect.      
    
Please remember the ID and PASSWORD you use when you leave us your message. In
order to receive your reply, you will have to log on using the same ID and 
PASSWORD.

What you need to know to connect
Our BBS number is 203-797-6872. You will need a 2400bps or higher speed modem to
access the board.    

Set your communications software to:
DATA BITS=8
PARITY=N 
STOP BITS=1

Don't forget that Windows 3.1 comes with a communications program called 
"Terminal" which you can use to log on to the Grolier BBS.



The Main Screen

The Main Screen allows you to access the five main modes of The Multimedia Encyclopedia 
of Science Fiction:

Archives
Book Browser
Time Machine
Gallery
Themes

It also allows you to access the Help system and to exit (Quit) the product.

To enter any of the first four modes, simply click the modes title from the Main Screen. Or, 
you may enter Themes mode by selecting from the six themes also listed on the Main 
Screen:

Time
Space
Science & Technology
Life Forms
Mind & Spirit
About SF

Simply click the theme you are interested in to access it.

You can also access Help or exit the product by clicking Help or Quit (on the lower-right of 
the Main Screen). 



Archives

Once you have selected Archives from the Main Screen (or from the Navigation menu), you 
will have access to the 6,000+ entries in the encyclopedia. Like the other modes, Archives is
divided into a Content Region (on the left) and an Info Region (on the right). 

The Archives Info Region will initially contain a list of the categories you can select from 
along with access to Word Search, Collections, History and the ability to switch between 
modes.

Click All Articles, or another category from the Archives category list (All Articles, Authors, 
Films & TV, Publications & Art, Terms & Themes, The SF Community), and a list of all of the 
articles in that category will appear.    

You can browse the list of articles by using the scrollbar, or the PgUp and PgDn keys. Or, you 
can use the Speed Scroll box located immediately above the Item list in the Info Region to 
type in a title, or portion of a title, and jump to that item or section of the list. Double-click 
an article title to display the article in the Archives Content Region. A preview of any items 
related to that article will also be displayed in the Content Region. Click the View button to 
open the related item to full size.

Double-click another title (or use the Speed Scroll box) to access another article.

The five buttons located above the word Archives in the Info Region can be used to quickly 
switch modes in the encyclopedia. Simply move your mouse over the buttons and a label 
indicating the mode that that button represents will appear. The button for the mode you are
currently in will appear on a white background. Simply click a button to switch modes.

The History and Collection buttons are located on the lower portion of the Info Region. 
Immediately below these are the Add to Collection, Open Collection, Word Search, Go to 
Main Screen, and Quit buttons. Simply move your mouse over the buttons and the 
corresponding label will appear. 



Book Browser

The Book Browser feature contains a collection of 300 SF book plot summaries; most are 
illustrated with book covers and have related media. Like the other modes, Book Browser is 
divided into a Content Region (on the left) and an Info Region (on the right).

The Book Browser Info Region will initially contain a list of 12 subject categories along with 
access to Word Search, Collections, History and the ability to switch between modes.

Click Select All, or limit your browsing by selecting one (or more) of the 12 categories. Click 
List Books to browse through the summaries available.    

Double-click a Book Browser title and that summary will be displayed in the Book Browser 
Content Region. A preview of any items related to that Book Browser will also be displayed in
the Content Region. Click the View button to open the related item to full size.
 
The five buttons located above the word Book Browser in the Info Region can be used to 
quickly switch modes in the encyclopedia. Simply move your mouse over the buttons and a 
label indicating the mode represented by that button will appear. The button for the mode 
you are currently in will appear on a white background. Simply click a button to switch 
modes.

The History and Collection buttons are located on the lower portion of the Info Region. 
Immediately below these are the Add to Collection, Open Collection, Word Search, Go to 
Main Screen, and Quit buttons. Simply move your mouse over the buttons and the 
corresponding label will appear.



Info Region

The Info Region, found in each of the five modes of the encyclopedia, provides easy access 
to all of the main tools in the encyclopedia.

History
Collection
Add to Collection
Open Collection
Word Search
Go to Main Features
Quit

The Info Region also makes accessing the five modes of the encyclopedia easy:

Archives
Themes
Time Machine
Book Browser
Media Gallery

When you first access any mode, a list of your choices within that mode will appear in the 
Info Region. As you begin selecting categories and items, additional information will appear. 
Once you select an item from a list, that item will be displayed in the Content Region.



Content Region

The Content Region, found in each of the five modes of the encyclopedia, is the area in 
which selected items are displayed.

Once an item has been selected from one of the categories in the Info Region, it will be 
displayed in the Content Region. Any media related to the item (pictures, movies, etc.) will 
also be listed in the Content Region.



Time Machine

Time Machine puts it all in perspective by showing milestones in the history of SF along with 
historical events in the real world. Like the other modes, Time Machine is divided into a 
Content Region (on the left) and an Info Region (on the right). 

Once Time Machine has been selected from the Main Screen or Navigation menu, the first 
timeline (1500-1840) will open in the Content Region. A list of all of the available timelines 
will appear in the Info Region. 

To learn more about the events listed, simply click them. A window containing either text, or 
a sound player will open. To hear the sound, simply use the controls. To close the window 
and continue, double-click the Close box. You can switch from one timeline to the next (or 
the previous) by clicking the arrows on the top right and left of the timeline screens, or by 
selecting another era from the list.

Note: The lowest gray bar lists historical events for reference only (they are not clickable).

As with the other modes, the Time Machine Info Region contains access to Word Search, 
Collections, History and the ability to switch between modes.

The five buttons located above the word Time Machine in the Info Region can be used to 
quickly switch modes in the encyclopedia. Simply move your mouse over the buttons and a 
label indicating the mode that that button represents will appear. The button for the mode 
you are currently in will appear on a white background. Simply click a button to switch 
modes.

The History and Collection buttons are located on the lower portion of the Info Region. 
Immediately below these are the Add to Collection, Open Collection, Word Search, Go to 
Main Screen, and Quit buttons. Simply move your mouse over the buttons and the 
corresponding label will appear.



Gallery

The Gallery mode enables you to access all of the multimedia elements within the 
encyclopedia directly. Like the other modes, the Gallery is divided into a Content Region (on 
the left) and an Info Region (on the right).

The Gallery Info Region will initially contain a list of the six media types found in the 
encyclopedia, access to Word Search, Collections, History, and the ability to switch between 
modes. 

Click All Media Titles, or select a type, and a list of media titles will appear in the Info Region.
A small icon will appear to the left of each title indicating its type. You can browse the list by 
using the scrollbar, or the PgUp and PgDn keys. Or, you can use the Speed Scroll box located
immediately above the Item list to type in a title, or portion of a title, and jump to that item 
or section of the list. 

Double-click a title and the media you have selected will be displayed in the Content Region.
A caption, and a Link to Article button will also appear. Click the Link to Article button and a 
list of the articles associated with the media will be displayed.

Note: If the media that you have selected is a movie, a set of movie player controls will 
open. Simply use the controls to start, pause, or rewind the movie.

The five buttons located above the word Gallery in the Info Region can be used to quickly 
switch modes in the encyclopedia. Simply move your mouse over the buttons and a label 
indicating the mode represented by that button will appear. The button for the mode you are
currently in will appear on a white background. Simply click a button to switch modes.

The History and Collection buttons are located on the lower portion of the Info Region. 
Immediately below these are the Add to Collection, Open Collection, Word Search, Go to 
Main Screen, and Quit buttons. Simply move your mouse over the buttons and the 
corresponding label will appear.



Themes

The six main themes in the encyclopedia allow you to explore ideas across different subjects
and media. 

Select a theme from the Main screen, or from the Navigation menu, and that themes main 
screen will open in the Content Region. 

The following will appear in the Theme Info Region: all of the themes, a list of the current 
themes articles, access to Word Search, Collections, History, and the ability to switch 
between modes. Each theme will have an overview and several main theme movies. You can
access these by clicking on each title in the Theme Content Region. Once you have selected 
a theme movie it will open in the Content Region along with movie player controls. Simply 
use the controls to start, pause, or rewind the movie. Click the Done button after you have 
viewed the movie. Click the Link to Article button to view a list of articles associated with the
Theme movie.

Each theme will also have a number of theme articles. These will be listed in the Theme Info 
Region. Simply double-click a Theme article and it will be displayed in the Content Region. If 
that theme article has any related items, a preview of the item will also be displayed in the 
Content Region. Click the View button to open the related item to full size.

The five buttons located above the word Themes in the Info Region can be used to quickly 
switch modes in the encyclopedia. Simply move your mouse over the buttons and a label 
indicating the mode represented by that button will appear. The button for the mode you are
currently in will appear on a white background. Simply click a button to switch modes.

The History and Collection buttons are located on the lower portion of the Info Region. 
Immediately below these are the Add to Collection, Open Collection, Word Search, Go to 
Main Screen, and Quit buttons. Simply move your mouse over the buttons and the 
corresponding label will appear.



 Word Search

Word Search, located in the lower portion of the Info Region is available from within all 
modes of the encyclopedia.

Simply click the Word Search icon and the Word Search dialog will open in the Info Region. 
You can search the entire encyclopedia for your term(s) by selecting the Entire Encyclopedia 
option, or you can specify the area you wish to search by using the Within and Set Criteria 
options.

Once you have specified which areas you wish to search, you can use the AND and OR 
Operators and Wildcards to make your search more controlled and powerful.

Once you have finished configuring the word search, click the Search button to 
perform the word search. A list of all of the items found will open in the Info Region. 
Use the scrollbar or the PgDn and PgUp keys to scroll through the list. Select an item 
by double-clicking it and it will open in the Content Region.

Click the Reset button to reset the search, erasing all Search Words and resetting any 
operators or other options you have changed.



Operators and Wildcards
Word Search incorporates several operators and wildcards to help make searching easier 
and more powerful:

AND
This lets you search for two or more words in a single article (each Search Word must 
appear in the article at least once).

OR
This lets you search for two or more words in a single article (at least one Search Word 
must appear in the article).

Wild Card (single character)
This will find all instances where your Search Word(s) plus any single letter forms a word 
(e.g., QUOT? will match "quota" and "quote").

Wild Card (multiple characters)
This will find all instances where your Search Word(s) plus any number of letters forms a 
word (e.g., QUOT* will match "quota,"    "quotation," "quoted," "quotes," etc.).



File Menu

The following commands are available from the File menu:

Save As...
Print
Exit



Edit Menu

The following commands are available from the Edit menu:

Copy
Select All



Collections Menu

The following commands are available from the Collections menu:

New Collection
Open Collection
Add Item to Collection
Delete Current Item
Delete Collection



Navigation Menu

The following commands are available from the Navigation menu:

Archive
Themes
Time Machine
Book Browser
Gallery
Word Search
Main Screen



Collections

The Collections feature enables you to mark and store items for future reference. You can 
create more than one collection and add up to 256 items to each.

To open a collection (or to select a different collection) click the Open Collection button (on 
the lower portion of the Info Region), or select Open Collection from the Collections menu. A 
dialog will open allowing you to specify a new collection or to select from the collections 
listed.

Once you have opened a collection, you can add items to it by clicking the Add to Collection 
button (on the lower portion of the Info Region) or by selecting Add Item to Collection from 
the Collections menu.

To delete a collection select Delete Collection from the Collections menu and select the 
collection you wish to delete.

To delete an item from a collection, you must first open the item by double clicking it in the 
collection window.    Once the item is displayed, select Delete Current Item from the 
Collections menu.

To view an item in a collection simply double-click it from the collection list.



History

The History feature maintains a list of all of the items that you have previously looked at. 
Simply click the History button (located on the lower portion of the Info Region) and a list of 
the items will appear. Scroll the list until you find the item you wish to return to, and double-
click it to open it. The History feature is available from all modes within the encyclopedia.



Text Display

All articles, Book Browsers, and Timeline captions will open in the Content Region. Longer 
articles are scrollable using the scrollbar or PgDn and PgUp keys. There are also two kinds of 
hyperlinks available within the text: 

- Clicking on a word that appears in magenta will bring you to another related article. 

- Clicking on a word that appears in blue will bring you to a related Book Browser. 

Use History if you wish to return to an article that you have hyperlinked from.



Save As... (File menu)

You may save all of the text and pictures in the encyclopedia. Select Save from the File menu
and a standard dialog box will open asking you to specify the filename and location you wish
to save to. Text will be saved in ASCII format; pictures will be saved in Windows bitmap 
(.BMP) format.



Print (File menu)

Use this to print the currently displayed text or picture. A standard Windows dialog box will 
open allowing you to specify things such as number of copies, etc.



Exit (File menu)

Use this command to exit the encyclopedia.



Copy (Edit menu)

Use this to copy the currently selected text. You may use this text in other Windows 
programs (e.g., word processing programs).



Select All (Edit menu)

Select All allows you to highlight all of the text you are currently viewing. Use this command 
when you wish to copy an entire article, Book Browser, or caption to your clipboard.



New Collection (Collections menu)

This command allows you to create a new collection to which you can then save items for 
future reference.



Open Collection (Collections menu)

This command allows you to open existing collections so that you can add or delete items 
from them. Note: You must first create a collection using New Collection before you can open
a collection.



Add Item to Collection (Collections menu)

This command allows you to add the item you are currently viewing to your currently active 
collection. 



Delete Current Item (Collections menu)

This command allows you to remove the item you are currently viewing from your collection.



Help Menu

The following commands are available from the Help menu:

About this Disc
Help (Contents)



Help Contents (Help menu)

Help Contents lists (in outline form) all of the Help topics available in the encyclopedia.



About this Disc

About this Disc contains information about The Multimedia Encyclopedia of Science Fiction, 
its creators, acknowledgments, copyright information, and the conventions that are utilized.



Delete Collection

To delete a collection select Delete Collection from the Collections menu and select the 
collection you wish to delete.

 




